RMC200 MOTION CONTROLLER

STARTUP GUIDE

With wiring diagrams
Where to Get Help

Video Tutorials

In RMCTools, on the Help menu, click Video Tutorials.

RMCTools Help

In RMCTools, on the Help menu, click Help Topics.

Forum

forum.deltamotion.com

Delta Technical Support

Phone: +1-360-254-8688
Email: support@deltamotion.com

Version 1.05, August 16, 2019
Copyright © 2019, Delta Computer Systems, Inc.
Before using the RMC200 motion controller, read this Startup Guide and relevant manuals carefully.

Installing, putting into service, using, and maintaining the RMC200 must be carried out by suitably trained personnel.

**Relevant documentation:**

- **RMCTools User Manual:** provides information on using the RMC200 motion controller. This information is also provided in the RMCTools software help topics.
- **RMC200 Datasheet:** includes full specifications of the modules.

**Maintenance:** The RMC200 contains no user-serviceable parts. The RMC200 should be repaired only by personnel authorized by Delta.

**Notices used in this document:**

**WARNING:** Identifies information about circumstances that can lead to personal injury or death, property damage, or economic loss.

**IMPORTANT:** Identifies information that is important for successfully applying the product.
**WARNING:** Using this product in a manner not specified by the manufacturer may impair the protection provided by the equipment.

**WARNING:** Employ safety circuits or devices external to the motion controller to ensure the machine operates safely even in the event of a failure in any part of the controller.

**WARNING:** If deemed necessary by a risk assessment, employ an emergency stop system to avert harm or to reduce existing hazards to persons, machinery, or work in progress.

**WARNING:** Use proper lock-out procedures when working on the machine to prevent injury or machine damage.

**WARNING:** On hydraulic systems, use blocking valves or other suitable methods to prevent the hydraulic system from moving unexpectedly when working on the machine.

**WARNING:** Use fuses to limit any fault currents that could cause smoke or fire due to a fault in the RMC or external device.
Contents

Step 1: Mount the Base .......................................................... 2
Step 2: Mount the Modules .................................................... 4
Step 3: Wiring ........................................................................ 5
Step 4: Install RMCTools ....................................................... 6
Step 5: Connect RMC to PC ................................................... 7
Step 6: Start a New Project .................................................... 8
Step 7: Define the Axes ......................................................... 13
Step 8: Test each Actuator ..................................................... 15
Step 9: Test each Feedback Device ................................. 19
Step 10: Scale and Offset ...................................................... 24
Step 11: Set the Output Polarity .......................................... 25
Step 12: Tuning ................................................................. 26
Continuing the Motion Application ................................ 29
Diagnostic Tools ............................................................. 32
Appendix A: Wiring ............................................................... 33
Appendix B: Mounting Dimensions ............................... 52
Appendix C: Agency Compliance ........................................ 54
**Step 1: Mount the Base**

The RMC base should be mounted upright on a vertical surface, such that the module ventilation holes are on the top and bottom.

**Mounting the Base on a Panel**

Mounting holes sized for #10 or 5mm screws.

See Appendix B: Mounting Dimensions on pg. 52 for more details.

**Clearance**

The required clearance above and below for airflow depends on the maximum ambient temperature:

<table>
<thead>
<tr>
<th>Ambient Temperature</th>
<th>Clearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>122 - 140°F (50 - 60°C)</td>
<td>3 in. (7.6 cm)</td>
</tr>
<tr>
<td>Less than 122°F (50°C)</td>
<td>2 in. (5.1 cm)</td>
</tr>
</tbody>
</table>

**Environment**

The environment must conform to the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating ambient temperature</td>
<td>-4 to +140°F (-20 to +60°C)</td>
</tr>
<tr>
<td>Storage ambient temperature</td>
<td>-40 to +185°F (-40 to +85°C)</td>
</tr>
<tr>
<td>Ambient humidity</td>
<td>5-95%, non-condensing</td>
</tr>
</tbody>
</table>

Keep liquids and conductive particles away from the RMC200.
**Enclosure**

If the RMC200 is installed in an electronics enclosure, the enclosure must be large enough to dissipate the power that is being generated by the components in the cabinet without having the air temperature in the cabinet exceed the rating on any of the components within the cabinet.

To ensure sufficient convection, the enclosure should provide the following clearances:

- At least 2” between front of RMC200 and enclosure
- At least 3” between top of RMC200 and enclosure
- At least 3” plus space for wires between bottom of RMC200 and enclosure

**Grounding**

**IMPORTANT:** Make sure to properly ground the base metal. Mounting via steel screws to a well-grounded surface such as a metal panel will typically suffice. To ensure a robust connection, the grounding stud on the bottom of the base may be used. The Case pins of each module are electrically connected to the module chassis, which will conduct to the base chassis.

**WARNING:** Electrostatic Discharge (ESD): Electrostatic discharge can cause internal damage and affect normal operation. When handling this equipment, follow these guidelines:

- Touch a grounded object to discharge potential static or wear a grounding wrist strap.
- Do not touch connectors or pins on the module boards, or electronic components inside the modules.
- Use a static-safe workstation, if possible.
- Store modules in ESD packaging when not in use.
Step 2: Mount the Modules

Module Locations

Modules may only be installed in compatible slots on the base. Modules are keyed so only compatible modules mount in a given slot.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Compatible Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>PS4D (B5, B7 and B11)</td>
</tr>
<tr>
<td></td>
<td>PS6D (B15)</td>
</tr>
<tr>
<td>1</td>
<td>CPU40</td>
</tr>
<tr>
<td>2+</td>
<td>CA4, CV8, S8, A8, Q4, D24, U14</td>
</tr>
</tbody>
</table>

Install each Module

1. Tip the module up.
2. Set the upper pins in the hooks.
3. Rotate the module down carefully such that the base connector engages.
4. Tighten the holddown screw to 5 in-lbs (0.6 Nm).
**Step 3: Wiring**

Wire the power, actuators and feedback devices to the RMC according to the instructions in *Appendix A: Wiring* on page 33.

**IMPORTANT:** Remove external power from the device before wiring. Failure to do so may cause component failure.

After wiring, remove the protective plastic from the top of the modules.

---

### Wiring Topic

<table>
<thead>
<tr>
<th>General Wiring Information</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS4D, PS6D</td>
<td>36</td>
</tr>
<tr>
<td>CA4, CV8, U14</td>
<td>38</td>
</tr>
<tr>
<td>A8, U14</td>
<td>43</td>
</tr>
<tr>
<td>CPU40, CA4, CV8, U14</td>
<td>37</td>
</tr>
<tr>
<td>D24</td>
<td>49</td>
</tr>
<tr>
<td>S8, U14</td>
<td>39</td>
</tr>
<tr>
<td>S8, U14</td>
<td>41</td>
</tr>
<tr>
<td>S8</td>
<td>48</td>
</tr>
<tr>
<td>Q4, U14</td>
<td>46</td>
</tr>
<tr>
<td>D24</td>
<td>51</td>
</tr>
</tbody>
</table>
Step 4: Install RMCTools

Download

1. Go to http://www.deltamotion.com/dloads/

2. Choose the RMC200 section, then choose the Software section.

3. Choose RMCTools, 32-bit or 64-bit, as required for your computer. RMCTools supports the RMC70, RMC150 and RMC200 controllers.

4. Run the rmctoolsinstall32.exe or rmctoolsinstall64.exe file and follow the instructions.

Start RMCTools

On the Windows Start menu, choose All Programs and then RMCTools.

<table>
<thead>
<tr>
<th>PC Requirements for RMCTools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
</tr>
<tr>
<td>Windows® 7/8/10</td>
</tr>
</tbody>
</table>
**Step 5: Connect RMC to PC**

**USB Cable**
Connect an A to B USB cable to the PC and to the RMC200 **USB** port.

This type of USB cable is typically used for PC peripherals such as printers, and is available at any store that sells electronics.

**Or, use Ethernet Cable**
Connect an Ethernet cable to the RMC200 and the PC or Ethernet switch. The RMC200 supports both straight through and crossover cables.

**Setting the IP Address**

The IP address need not be set before connecting via Ethernet. If the PC is on the same physical Ethernet network as the RMC, RMCTools can detect the RMC even if the IP address is not set.

The RMC’s IP address and subnet mask can be set via RMCTools while connecting via Ethernet. See the next step **Start a New Project** for details.

Or, set the IP address and subnet mask via the CPU display screen:

1. Using the **Menu**, arrow and **Enter** buttons, browse to: **Ethernet → Change IP Address → Set manually**
2. Using the arrow buttons, set the IP address.
3. Press **Enter** for Next and set the subnet mask.
4. Press **Enter** for Next and use the arrow and **Enter** buttons to choose whether to use a default gateway. Set it if so desired.
Step 6: Start a New Project

1. Start RMCTools.
   In the **Startup** dialog, choose **Create a New Project** and click **OK**.

2. Enter the **Project Name**, then click **Finish**.

3. In the **New Controller Wizard**, choose **Automatically Detect the Controller Information**, then click **Next**.
4. **Communication Method:**

   **Via USB:**

   A. Choose USB and click **Next**.

   B. The RMC200 will appear in the list as **R200-CPU40**. Choose the RMC and click **Next**.

   ![Image](image1.png)

   **Tip:** If multiple controllers are listed, use the serial number to identify your RMC in the list (Device ID). The serial number is accessible on the RMC200 display screen:

   1. Using the **Menu**, arrow **ıld** and **Enter** buttons, browse to: **Module Info → Slot 1 (CPU40)**

   2. The serial number is prefixed by **SN**:

   ![Image](image2.png)

   C. RMCTools will connect to the RMC and display it. Verify it is correct, then click **Finish**.

   ![Image](image3.png)
Via Ethernet:

A. Choose Ethernet and click Next.

B. The RMC200 will appear in the list as R200-CPU40. Click the RMC and click Next.

Tip: If multiple controllers are listed, use the MAC address to identify your RMC in the list. The MAC address is accessible on the RMC200 display screen:

1. Using the Menu, arrow and Enter buttons, browse to:
   Ethernet → View IP Address
2. Using the arrow buttons, scroll down to view the MAC address.

C. If the RMC does not have an IP address (0.0.0.0), you must set an IP address now in order to connect via Ethernet:

   a. Click Configure Device.
b. Choose **Use the following IP address**, set the **IP Address** and **Subnet Mask**, then click **OK**.

**Tip:** For help on IP addressing, in the RMCTools help, in the **Index** tab, type **IP Address** and choose that item from the list.

D. Click **Next**. RMCTools will connect to the RMC and display it. Verify it is correct, then click **Finish**.

5. The toolbar now displays **Online (Disabled)**. This means RMCTools is communicating with the controller.

**Project Pane**

The project pane contains all the items in the project. Use the Project pane to navigate through the entire project.
Set Up Module Channels

If your RMC200 includes a U14 or S8 module, you may first need to set up the high-speed channels before using them as part of an axis.

**U14:** The channels can be configured as SSI, MDT, or quadrature.

**S8:** Channels 7-8 can be configured as an SSI input (default), SSI monitor, or a quadrature input.

1. In the Project pane, expand the **Modules** folder and double-click the module.

2. On the **Configuration** page, choose the desired mode for each channel. For more details, click **Help**.

Saving Settings

Throughout the startup procedure, make sure to save the configuration changes you make or they may be lost!

1. **Save RMCTools Project**

   On the **File** menu, click **Save**.

2. **Update Flash**

   On the **Controller** menu, click **Update Flash**.

   **IMPORTANT:** If you do not update Flash, changes to the RMC will be lost when power is removed!

3. **Repeat Often**

   Make sure to save often to prevent loss of data.

   **Tip:** On the **File** menu, click **Save and Update Flash** to perform both operations at once.
Step 7: Define the Axes

To use a physical input or output, it must be assigned to an internal software axis. The RMC starts with default axis assignments which you will likely need to change.

Make sure to define the axes at the start of the project. Major changes to axis definitions later may result in lost axis parameters.

Example Axis Definitions

Position Control Axis
One Control Output, one position input.

Position-Force Control Axis (all part of a single axis)
One Control Output, one position input, dual-input force

Reference Axis
One position input.

---
deltamotion.com
View Axis Definitions

1. In the Project tree, expand the Axes folder and double-click Axis Definitions.

2. The Axis Definitions dialog opens:

   The list displays the software axes. To see the assigned hardware, click an axis in the list.
   The hardware assigned to that axis will be highlighted in the image.

Edit Axis Definitions

Use the Axis Definitions dialog to change the axis definitions:

- Click New to add an axis.
- Click Change to edit the selected axis.
- Click ∇ to remove an axis.

If you need to make significant changes to the axis definitions, first delete all the axes, then create new ones.

For more details, click the Help button.

After changing axis definitions, save the project and update Flash.
Step 8: Test each Actuator

You will now test an actuator such as a hydraulic valve or a motor. You will use the Direct Output command to send a command signal to the actuator. The actuator must already have been wired to the RMC.

Set the Output Type

1. In the Project tree, double-click **Axis Tools**.

2. In the **Axis Parameters**, on the **Setup** tab, set the **Output Type** to the correct setting for your actuator.

   Supported output types:
   - Voltage output: CA4, CV8, U14
   - Current output: CA4, U14

3. Click the **Download** button to apply the changes to the RMC.

4. In the **Axis Status Registers**, on the **Basic** tab, look at the **Control Output**.

   It should be 0.

   Notice that the **Final Output** shows the output value in Volts or mA.
Enable the Axes – Enable Controller (7) Command

5. In the Command Tool, in any axis box, click the button.

6. Browse to General Commands, click Enable Controller, then click OK.

   The Enable Controller command enables all the axes so motion commands can be sent to them.

7. In the Command Tool, click Send.

   All the axes will now be enabled, as indicated by the Enabled Status bit in the Axis Status Registers.

   Entering RUN Mode will also enable the axes.
Step 8: Test each Actuator

Move the Axis - Direct Output (9) Command

**WARNING:** Use the Direct Output (9) command with caution. It disables the Autostop features of the axis.

**Fault Controller Button**
In the next steps, if you need to quickly stop the axis, click the **Fault Controller** button on the toolbar, or press **Ctrl + K** on the keyboard.

8. In the Command Tool (see step 5) browse to **Motion Commands**, then **Open Loop**.
Choose the **Direct Output** command and click **OK**.

The Direct Output command is useful for setup because it ignores all axis errors.

9. For the Direct Output command parameters, enter the following:
   - **Output (%):** 10
   - **Ramp Rate:** 1000

When you send the command in the next step, the Control Output will ramp to 10 % output at a rate of 1000 %/sec. This means an axis configured for ±10 V output will ramp the Control Output to 1 V in 10 ms.
10. In the Command Tool, click **Send**.

   The axis should move, and the **Control Output** (in the **Axis Status Registers**) should be 10.0.

11. If the axis did not move, resend the command with a larger **Output** until the axis moves.

   **Note:** If the Enable Output is wired to the actuator, before moving, set it with the **Set Enable Output** command.

12. Now stop the axis:
   In the Command tool, enter 0 in the **Output** box and click **Send**.

13. Repeat these steps to move the axis in the other direction. In the Direct Output command, use a negative **Output** value.
   Move the axis back and forth through the entire travel range to make sure the axis is moving properly.
Step 9: Test each Feedback Device

Now that you have connected and tested an actuator, you will verify a feedback device. The device must already have been wired to the RMC.

Configure Feedback

In Axis Tools, in the Axis Parameters pane, on the Setup tab, you will configure certain parameters depending on the type of input you are using.

Refer to the procedure for your transducer type and module:

<table>
<thead>
<tr>
<th>Transducer Type</th>
<th>Module</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSI</td>
<td>S8, U14</td>
<td>20</td>
</tr>
<tr>
<td>Start/Stop or PWM (Magnetostrictive)</td>
<td>S8, U14</td>
<td>21</td>
</tr>
<tr>
<td>Analog (Voltage or Current)</td>
<td>A8, U14</td>
<td>22</td>
</tr>
<tr>
<td>Quadrature Encoder</td>
<td>Q4, S8, D24, U14</td>
<td>22</td>
</tr>
</tbody>
</table>
SSI Feedback

1. In the Axis Parameters pane, on the Setup tab, set the Feedback Type to SSI.

2. Set the following parameters:
   - SSI Format
   - SSI Data bits (e.g. 24)
   - Linear/Rotary

   Choose Format and Data Bits per the SSI device data sheet. For linear transducers, choose Linear. For rotary encoders, choose Rotary if the axis on your machine can rotate continuously and the positions wrap around, or Linear if it has a limited travel range and the encoder will not cross the zero counts point.

   **Note:** For help on a parameter, click the cell and press F1.

3. Depending on the I/O module and the sensor, there may be other parameters that need to be set. See the SSI Fundamentals RMCTools help topic for your module for details.

4. Click the Download button to apply the changes to the RMC.

5. Continue to the Verify Feedback section on page 23.
Step 9: Test each Feedback Device

Start/Stop or PWM (Magnetostrictive) Feedback

1. In the **Axis Parameters**, on the **Setup** tab, set the **Feedback Type** to **MDT**.

2. Set **MDT Type** to the type of magnetostrictive transducer you have. This information is available from your transducer datasheet.

3. Click the **Download** button 🔄 to apply the changes to the RMC.

4. Continue to the **Verify Feedback** section on page 23.
Analog Feedback

1. In the **Axis Parameters**, on the **Setup** tab, set the **Analog Input Type** to **Voltage (±10V)** or **Current (4-20mA)**.

   If the input is the primary input of the axis, the **Input Type** is under the **Primary Control Setup** section in the Axis Parameters.

   For pressure or force inputs on a dual-loop axis, the **Input Type** is in the **Secondary Control Setup** section in the Axis Parameters.

2. Click the **Download** button to apply the changes to the RMC.

3. Continue to the **Verify Feedback** section on page 23.

Quadrature Feedback

1. In the **Axis Parameters**, on the **Setup** tab, set the **Linear/Rotary** parameter.

   For linear transducers, choose **Linear**. For rotary encoders, choose **Rotary** if the axis on your machine can rotate continuously and the positions wrap around, or **Linear** if it has a limited travel range.

2. Depending on the I/O module, there may be other parameters that need to be set, for example, to define the input signal levels. See the RMCTools help topic for your module for details.

3. Click the **Download** button to apply any changes to the RMC.

4. Continue to the **Verify Feedback** section on page 23.
Verify Feedback

1. In the **Axis Status Registers** pane, on the **All** tab, expand the **Feedback** section.

   For secondary inputs, expand the **Pressure/Force/Accel Feedback** section.

2. Depending on your feedback type, look at the **Counts**, **Volts** or **Current** register. It may be changing slightly.

3. Use the Direct Output command to move the axis back and forth (as described in the **Test an Actuator** section).

4. As the axis moves, look for a corresponding change in the **Counts**, **Voltage** or **Current**. If it does not change smoothly, recheck the wiring, verify that the parameters on the **Setup** tab are correct, and check for smoothly changing **Counts**, **Voltage** or **Current** again.

5. Save the project and update Flash.
Step 10: Scale and Offset

The Scale and Offset parameters convert the Counts, Volts or Current from the transducer into meaningful measurement units.

First, determine the approximate positions at either end of travel. This will help you verify later that you performed the procedure correctly.

To set the Scale and Offset:

1. Go to the Axes Parameters pane, Setup tab, Tools and Wizards section.

2. Click Launch for the Scale/Offset Wizard in the desired axis.

3. In the wizard, follow the directions. For help, press the Help button.

Tip: If the wizard does not work for your system, you can manually determine the Scale and Offset parameters. See the Scaling topic in the RMCTools help for details.

4. After completing the wizard, in the Axis Parameters, locate the Display Units parameter.

Select the desired display units. If you wish to use units that are not listed, choose Custom, then type up to 4 characters in the Custom Units parameter.

5. Click the Download button 🔄 to apply the changes to the RMC. Remember to save your project and update Flash.
Step 11: Set the Output Polarity

**IMPORTANT:** The Actual Position, Pressure, Force or Velocity *must increase* when the RMC applies a *positive* Control Output percentage. If this condition is not met, you will not be able to perform closed-loop control.

1. Send the Direct Output command with a positive Output value that is large enough to move the axis.

2. On the Basic tab of the Axis Status Registers pane, observe the Actual Position and note whether it is increasing or decreasing:
   - **Increasing**
     The Output Polarity is correct. Go to Enable the Axes below.
   - **Decreasing**
     You must invert the Output Polarity:
     
     A. In the Axis Parameters pane, on the Setup tab, double-click the Invert Output Polarity parameter to set it.

     B. Click the Download button to apply the change to the RMC.
Step 12: Tuning

In order to control an axis in closed-loop, it must first be tuned. You can use autotuning or manually tune the axis.

Autotuning – Position Axes Only

Autotuning can be used for most position control axes.

1. **Open Tuning Tools**
   On the **Tools** menu, click Tuning Tools.

2. **Set Up Tuning Tools**
   Set up the buttons that you will use to move the axis back and forth after the tuning wizard completes.
   - Click the first button labeled [Click to set up].
   - Enter a **Move Absolute** command with position, speeds, and acceleration values that will work for your system.
   - Repeat for the other button, with a different position.

3. **Start the Tuning Wizard**
   In the Tuning Tools, click Tuning Wizard.

4. **Complete the Tuning Wizard**
   During the autotuning, the wizard will move the axis a short distance when you prompt it to.
5. When the wizard is complete, the **Gain Calculator** will open. Use the slider bar to choose gains. Begin by pulling the slider close to the bottom, then click **Apply Gains**.

![Gain Calculator](image)

6. Use the buttons you previously set up to move the axis back and forth. The plot will automatically be displayed.

   **Tip:** To halt the axis, click the **Fault Controller** button on the toolbar, or press Ctrl+K.

7. If the Actual Position is not following the Target Position very well, pull the slider bar up, apply gains, and move the axis again. Repeat until the Actual Position tracks the Target Position as required for the application.

**Tuning With an Existing Plot**

If the autotuning does not work for your system, you can use the Tuning Wizard with an existing plot.

1. In the Tuning Tools, use the move buttons to make moves and adjust the Proportional Gain until the axis has some control.
2. Start the Tuning Wizard and choose **Use Existing Plot**. The Wizard will prompt you to choose one of the plots of the moves you made.
3. When the wizard completes, use the Gain Calculator as described above.
**Manual Tuning—Position, Pressure, or Force Axes**

You can manually tune systems for which autotuning does not work. For instructions:

1. On the help menu, choose **Help Topics**.
2. On the **Index** tab, type **tuning** and double-click **about**.
3. The **Tuning Overview** topic describes tuning. In the **Manual Tuning** section, choose a procedure. For most position control applications, choose **Tuning a Hydraulic Position Axis or Motor in Velocity Mode**. For pressure or force, choose the procedure that applies to your axis.

After tuning, save the project and update Flash.
After setting up and tuning the RMC, it is ready to perform motion and be integrated into the rest of your application. The RMC has numerous features to assist you. The major components are listed here to guide you when continuing your motion application.

**Commands**

The RMC has a rich set of pre-programmed commands that perform anything from simple moves to complex motion to system control. For a list of all the commands, see the Command List topic in the RMCTools help.

**User Programs**

A User Program carries out simple or advanced sequences of commands on the RMC. This allows the RMC to respond to events within its control-loop time rather than the scan rate of a PLC or other host controller. It also reduces the PLC programming required.

A User Program consists of multiple steps linked together in sequences. Each step can issue any RMC command to one or several axes. The link types allow branching and looping, waiting for conditions and many other features. Simple and complex mathematical operations are also possible in the user program.

A User Program runs on a task. Each task can run one user program at a time. The RMC200 has up to 32 tasks. Therefore, an RMC200 controller may run up to 32 User Programs simultaneously.

For details on creating and running User Programs, see the User Programs topic in the help.
Communications

Most PLCs or other host controllers can communicate with the RMC, which includes reading status, writing values, and sending commands to the RMC. The RMC200 supports a number of Ethernet protocols.

**WARNING:** When the motion controller is remotely controlled by some other device, such as a PLC, make sure to design proper safety interlocks to ensure safe machine operation in the event of communications loss.

See the **Communications** section of the RMCTools help for more detailed information.

Discrete I/O

Discrete I/O augments the communications of the RMC. Discrete I/O is often faster than the communications, and is therefore well-suited for starting a sequence in the RMC at a specific time. See the **Discrete I/O** topic in the RMCTools help for details.

Variables

Variables help make the User Programs very flexible and easy to maintain. Variables can be used to effortlessly change programs and easily modify User Program parameters via a PLC. Variables can also be used to store data.

For details on using variables, see the **Variables** topic in the help.
Program Triggers

Use the Program Triggers to start User Programs based on conditions defined by the user. For example,

- Start a User Program by writing to an RMC variable from a PLC.
- Start a User Program when a discrete input turns on.
- Automatically start a User Program when the RMC starts up.
- When an error condition occurs, automatically start a User Program to handle it.

See the Program Triggers topic in the RMCTools help for details.
Diagnostic Tools

This section describes the main diagnostic tools of RMCTools that will aid you in monitoring and troubleshooting your system.

Plots

The RMC provides very flexible plotting capabilities. Virtually any register in the RMC can be plotted, and multiple registers may be plotted simultaneously. You can easily capture events with the plot trigger. For details on using plots, see the Plots topics in the help.

**Note:** By default, each axis has a plot configured and a plot will be captured each time a motion command its sent to the axis.

Open the Plot Manager and click **Capture** to view a plot.

Or, click **Trend** to view a continuous plot.

Event Log

The Event Log Monitor displays all events that have occurred in the controller, such as issued commands, changed parameters and errors. The Event Log can help you:

- Determine if a command was successfully issued. The entire command, with parameters, is displayed.
- Find out which, if any, error occurred.
- See where a command was issued from, for example, from a PLC, from a User Program or from the Command Tool.

**To open the Event Log:**

- In the Project Pane, expand the controller, and double-click **Event Log**.

**Note:** The Event Log is very useful! When you don’t know what happened, or why something did not happen, look at the Event Log.
Appendix A: Wiring

This appendix describes how to wire the RMC. Use the table below to find the wiring diagram you need. For communications wiring, consult the RMCTools help.

⚠️ WARNING: Remove external power from the device before wiring. Failure to do so may cause the module to fail.

<table>
<thead>
<tr>
<th>Wiring Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Wiring Information</td>
<td>34</td>
</tr>
<tr>
<td>Power</td>
<td>PS4D, PS6D</td>
</tr>
<tr>
<td>Analog Outputs</td>
<td>CA4, CV8, U14</td>
</tr>
<tr>
<td>Analog Inputs</td>
<td>A8, U14</td>
</tr>
<tr>
<td>Discrete I/O</td>
<td>CPU40, CA4, CV8, U14</td>
</tr>
<tr>
<td></td>
<td>D24</td>
</tr>
<tr>
<td>SSI Inputs</td>
<td>S8, U14</td>
</tr>
<tr>
<td>Start/Stop and PWM (MDT)</td>
<td>S8, U14</td>
</tr>
<tr>
<td>Quadrature Encoder</td>
<td>S8</td>
</tr>
<tr>
<td></td>
<td>Q4, U14</td>
</tr>
<tr>
<td></td>
<td>D24</td>
</tr>
</tbody>
</table>

⚠️ WARNING: Miswiring may cause damage to the RMC200 and connected components.

⚠️ WARNING: Pay special attention to wiring the Common pins, or the RMC may not properly receive signals from connected transducers.
General Wiring Information

To minimize electrical interference:
- Use twisted pairs for all wiring where possible.
- Use shielded cables for all wiring.
- Keep RMC wiring separate from AC mains or conductors carrying high currents, especially high frequency switching power such as conductors between servo drives and motors or amplifiers and proportional valves.
- Use separate power supplies for sensors and actuators.

Unpluggable Terminal Blocks

All RMC200 modules employ unpluggable terminal blocks. Features of these terminal blocks include:
- **Latching type** to prevent unintended extraction
- **Spring-cage connectors** for consistent wire clamp force

Using Spring-Cage Connectors

Spring-cage connectors may be used for stranded copper wire or stranded copper wire with ferrules. Wire ferrules provide easy insertion.

Inserting stranded wire:
1. Press and hold the spring clamp actuator.
2. Insert wire.
3. Release spring clamp actuator.

Inserting wire with ferrule
1. Insert wire (may require some force).

Removing wire (stranded or ferrule):
1. Press and hold the spring-cage actuator.
2. Remove wire.
Wire Gauge, Stripping Length and Ferrule Length

**IMPORTANT:** Use copper wire only.

<table>
<thead>
<tr>
<th></th>
<th>PS4D, PS6D</th>
<th>CPU40, CA4, CV8, S8, A8, Q4, D24, U14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wire gauge, stranded</td>
<td>24 – 12 AWG 0.2 – 2.5 mm²</td>
<td>24 – 16 AWG 0.2 – 1.5 mm²</td>
</tr>
<tr>
<td>Wire gauge, ferrule</td>
<td>0.25 – 2.5 mm²</td>
<td>0.25 – 1.5 mm²</td>
</tr>
<tr>
<td>no plastic sleeve</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wire gauge, ferrule</td>
<td>0.25 – 2.5 mm²</td>
<td>0.25 – 0.75 mm²</td>
</tr>
<tr>
<td>with plastic sleeve</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stripping Length</td>
<td>10 mm</td>
<td>10 mm</td>
</tr>
<tr>
<td>Ferrule Length</td>
<td>10 – 12 mm</td>
<td>10 – 12 mm</td>
</tr>
</tbody>
</table>
Power (PS4D and PS6D)

Input Voltage:
Recommended 24 Vdc ±15% (20.4 – 27.6 Vdc), 30 V max.
Overvoltage shutdown at 36 V.

Input Power:
PS4D: 42 W max (1.8 A at 24 Vdc)
PS6D: 60 W max (2.5 A at 24 Vdc)
For a given power draw, the current draw will be greater at a lower input voltage.
Current draw varies based on number and type of modules installed in the base.

Power Wiring Diagram

Ferrite for CE EMC compliance. See appendix C on pg. 54.

The PS4D and PS6D Case pins are internally connected to the base chassis metal.
Appendix A: Wiring

Discrete I/O (CPU40, CA4, CV8, U14)

**CPU40:** 2 discrete inputs, 2 discrete outputs  
**CA4:** 4 discrete inputs (Fault), 4 discrete outputs (Enable)  
**CV8:** 8 discrete I/O, individually configurable as inputs or outputs  
**U14:** 4 discrete I/O, individually configurable as inputs or outputs

The CPU40, CA4, CV8, and U14 discrete I/O points are individually isolated.

**Discrete Inputs**

Apply 12-24 V to the input. The polarity can be positive or negative. Max current draw is 3 mA.

**Used with a sourcing output**

**Used with a sinking output**

![Diagram showing sourcing and sinking outputs]

**Discrete Outputs**

The discrete outputs are solid state relays. Outputs can be wired in either a high-side or low-side configuration.

<table>
<thead>
<tr>
<th></th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Impedance</td>
<td>15Ω max.</td>
</tr>
<tr>
<td>Max Current</td>
<td>75 mA</td>
</tr>
<tr>
<td>Max Voltage</td>
<td>30 V</td>
</tr>
</tbody>
</table>

![Diagram showing discrete output configurations]
Control Output (CA4, CV8, U14)

CA4: 4 analog outputs, individually software selectable as 0-10 V, ±10 V, 4-20 mA, ±20 mA, or a custom range.

CV8: 8 analog outputs, individually software selectable as 0-10 V, ±10 V, or a custom range.

U14: 2 analog outputs, individually software selectable as 0-10 V, ±10 V, 4-20 mA, ±20 mA, or a custom range.

Wiring to Differential Inputs

Differential inputs provide the best noise immunity. This is indicated by individual +, -, and cmn inputs on the drive or amplifier.

Wiring to Single-ended Inputs
SSI Transducer Wiring (S8, U14)

For Synchronous Serial Interface (SSI) transducers and encoders. For linear SSI transducers, make sure to choose the synchronized type. See the SSI Fundamentals help topic in RMCTools for details.

**Tip:** See next page for manufacturer-specific wiring diagrams.

**Notes:**
- The user must supply power to the transducer.
- Connect the encoder DC ground to the Cmn pin on the S8 module or the S/Q Cmn on the U14. The Cmn must be connected to the transducer, or the signals may not be read correctly!
**SSI Manufacturer-Specific Wiring**

These diagrams provide transducer manufacturer labels and colors. Follow all SSI wiring instructions on page 39.

**Balluff Micropulse BTL5 or BTL7 with SSI output**

**Styles:** Z, W, K, P

![Diagram showing Balluff Micropulse BTL5 or BTL7 connections]

- Yellow: + Clk
- Pink: - Clk
- Gray: + Data
- Green: - Data
- Blue: GND
- Brown: +24 V
- Do not connect Case pin to cable shield. Cable shield is internally connected to Balluff sensor housing.

**MTS Temposonics with SSI output**

**Models:** R, RP, RH

![Diagram showing MTS Temposonics connections]

- Yellow: (+) Clock
- Green: (-) Clock
- Pink: (+) Data
- Gray: (-) Data
- White: DC Ground
- Red or Brn: +24 Vdc
Appendix A: Wiring

Start/Stop or PWM Transducer Wiring (S8, U14)

For magnetostrictive transducers with Start/Stop or PWM outputs.

Tip: See next page for manufacturer-specific wiring diagrams.

Notes:
- The S8 and U14 modules interface to RS-422 (3.5-5V differential) signals. Single-ended (TTL) signals are not supported.
- The user must supply power to the transducer.
- Connect the encoder DC ground to the Cmn pin on the S8 module or the S/Q Cmn on the U14. The Cmn must be connected to the transducer, or the signals may not be read correctly!
Start/Stop and PWM Manufacturer-Specific Wiring

These diagrams provide transducer manufacturer labels and colors. Follow all MDT wiring instructions on page 41.

Balluff Micropulse BTL-5, digital RS-485 output

**Styles:** Z, W, K, E, P, R, AT

![Diagram of Balluff Micropulse BTL-5](image)

- Yellow: Interrogate + Input
- Pink: Interrogate - Input
- White*: GND
- Gray: Pulse + Output
- Green: Pulse - Output
- Blue: GND
- Brown: Pwr+

*White wire must remain unconnected.
Do not connect Case pin to cable shield. Cable shield is internally connected to Balluff sensor housing.

MTS Temposonics with digital output (Start/Stop or PWM)

**Models:** LH, LS, LD, LF, LPS, LPR, G, EP2, ER

![Diagram of MTS Temposonics with digital output](image)

- Yellow: (+) Interrogation or Start
- Green: (-) Interrogation or Start
- Pink: (+) Gate or (+) Stop
- Gray: (-) Gate or (-) Stop
- White: DC Ground
- Red or Brn: Cust. Supplied Pwr (+Vdc)

MTS Temposonics II with DPM or RPM personality module

![Diagram of MTS Temposonics II with DPM or RPM personality module](image)

- Yellow or Wh/Gy: (+) Interrogation
- Green or Gy/Wh: (-) Interrogation
- White or Wh/Bu: DC Ground
- Pink or Or/Wh: (+) Gate Out, (+) Start/Stop
- Gray or Wh/Or: (-) Gate Out, (-) Start/Stop
- Red or Wh/Gr: + VDC
- Blue or Gr/Wh: - VDC
- Brown or Bu/Wh: Frame
Analog Input Wiring (A8, U14)

Voltage Transducer, 4- or 5-Wire

Voltage Transducer, 3-Wire

To reduce electrical interference:
- **In**- and **Cmn** must be connected, either internally in the transducer or externally as close as possible to the transducer.
- Use individually shielded twisted-pair wire.
- Connect cable shield to earth ground on one end only.
- If transducer has only one common, connect Pwr Supply Common and RMC Cmn to it. For best results, make this connection at the transducer.
Potentiometer with Exciter Pin (A8)

**Note:** Use the Exciter pin to increase the measurement accuracy of the potentiometer.

To reduce electrical interference:
- The connection of In- to Cmn should be made as close as possible to the potentiometer.
- Use individually shielded twisted-pair wire.
- Connect cable shield to ground on one end only.
Analog Current Wiring 4-20 mA (A8, U14)

Current Transducer, 2-Wire

For three-wire transducers with a single shared common, the In-, RMC Cmn, and power supply Cmn should all be connected as close to the transducer as possible.

Current Transducer, 4-Wire

Input must be configured in software for current.

A8 input imped: 250 Ω
U14 input imped: 165 Ω

To reduce noise, use individually shielded twisted-pair wire.
**Quadrature Encoder Wiring (Q4, U14)**

**Important:** Set the **AB Input Type** and **Z Input Type** axis parameters in RMCTools to correspond to the physical signal level and type. See the RMCTools help for details.

### Differential Signal

![Differential Signal Diagram]

### Single-Ended Signal (not recommended)

![Single-Ended Signal Diagram]
Appendix A: Wiring

Q4 Home Inputs
Set the **H Input Type** axis parameter in RMCTools to correspond to the type of signal. See the RMCTools help for details.

![Q4 Home Inputs Diagram]

Q4 Registration Inputs
Set the **R Input Type** axis parameter in RMCTools to correspond to the type of signal. See the RMCTools help for details.

![Q4 Registration Inputs Diagram]

U14 Reg/Z Inputs
Set the **Z Input Type** axis parameter in RMCTools to correspond to the type of signal. See the RMCTools help for details.

**Differential:**

![U14 Differential Diagram]

**Single-ended:**

![U14 Single-ended Diagram]

Reg/Z- must be connected to Cmn.
Quadrature Wiring (S8)

The S8 supports one RS-422 quadrature encoder input, using channels 6 and 7.

Notes:
- The S8 module interfaces to RS-422 (3.5-5V differential) signals only. Single-ended (TTL) signals are not supported.
- The user must supply power to the encoder.
- Connect the encoder DC ground to the Cmn pin on the S8 module. The Cmn must be connected to the encoder, or the signals may not be read correctly!
D24: Discrete I/O Overview

The D24 discrete I/O are organized into 4 sections:

<table>
<thead>
<tr>
<th>DI/O #</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group A 0-7</td>
<td>Input or output – nominal 24V. Software-configurable. Each group is isolated. Within each group, all inputs share the same input common, and all outputs share the same output common.</td>
</tr>
<tr>
<td>Group B 8-15</td>
<td></td>
</tr>
<tr>
<td>Group C 16-19</td>
<td></td>
</tr>
<tr>
<td>Fast Inputs 20-23</td>
<td>Inputs only – 5V or 24V. High-speed. Each input is individually isolated. Configurable for pulse counters, quadrature inputs, and high-speed timing.</td>
</tr>
</tbody>
</table>

D24: Discrete Outputs

The D24 discrete outputs are solid state relays. When off, they have high impedance, and when on, they have low impedance.

Outputs can be wired in either a high-side or low-side configuration. Because all the outputs in a group share a common, all outputs in the same group must be wired the same.

<table>
<thead>
<tr>
<th>D24 Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Impedance</td>
</tr>
<tr>
<td>Max Current</td>
</tr>
<tr>
<td>Max Voltage</td>
</tr>
</tbody>
</table>
**D24: Discrete Inputs**

To turn on a discrete input, apply a voltage of the correct level. The polarity is unimportant for inputs 0-19, and is important for 20-23.

<table>
<thead>
<tr>
<th></th>
<th>Inputs 0-19</th>
<th>Inputs 20-23</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Signal Levels</strong></td>
<td>12-24 VDC</td>
<td>5-24 VDC</td>
</tr>
<tr>
<td><strong>Max Current Draw</strong></td>
<td>3 mA</td>
<td>7 mA</td>
</tr>
</tbody>
</table>

**Inputs 0-19**

Inputs 0-19 are polarity-independent and can be sinking or sourcing. Inputs 0-19 are divided in three groups: 0-7, 8-15, 16-19. Each group shares a common, so all inputs in a group must be wired the same.

**Used with a sourcing output**

**Used with a sinking output**

**Inputs 20-23**

Each input is individually isolated and has \texttt{Din}+, \texttt{Din} +5V, and \texttt{Din}– connections. Use only \texttt{Din}+ or \texttt{Din}+5V, not both.

**Example:**
D24: Quadrature Encoder

The D24 high-speed inputs 20-23 support the following quadrature encoder feedback and pulse train signal types:

- 5V Differential
- Differential HTL (High Threshold Logic) for 12V to 24 V
- RS-422
  RS-422 will only work in this configuration if the differential output is greater than 3.5V. Some RS-422 drivers may not provide sufficient voltage.
- TTL
- Push-pull 5V-24V without complements
- Open collector from 5V to 24 V
- RS-422 (3V)
  Use RS-422 in this configuration only if the differential output is less than 3.5V.

For detailed wiring diagrams, see the D24 wiring topic in the RMCTools help.
Appendix B: Mounting Dimensions

Clearance

The required clearance above and below for airflow depends on the maximum ambient temperature:

<table>
<thead>
<tr>
<th>Ambient Temperature</th>
<th>Clearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>122 - 140°F (50 - 60°C)</td>
<td>3 in. (7.6 cm)</td>
</tr>
<tr>
<td>Less than 122°F (50°C)</td>
<td>2 in. (5.1 cm)</td>
</tr>
</tbody>
</table>

Bases

See www.deltamotion.com/dloads/ for CAD files.
Appendix B: Mounting Dimensions

B7:

B11:

B15:

See www.deltamotion.com/dloads/ for CAD files.
Appendix C: Agency Compliance

**CE**

All RMC200 modules are CE compliant.

For CE compliance and to minimize electrical interference:
- Install a ferrite ring on the power wires to the PS4D or PS6D power supply module. Recommended ferrite is Fair-Rite 0431167281.
- Use twisted pairs for all wiring where possible.
- Use shielded cables for all wiring.
- Keep RMC wiring separate from AC mains or conductors carrying high currents, especially high frequency switching power such as conductors between servo drives and motors or amplifiers and proportional valves.
- Keep doors on modules closed during operation.

**UL and CUL**

File number: E141684

**RMC75, RMC150**

All modules are UL and CUL compliant.

**RMC200**

All modules are UL and CUL compliant.
Notes:
The RMC Family of Motion Control

Connect. Control. Optimize.